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Welcome to OpenBook 

OpenBook is an application that transforms your personal 
computer and scanner into a full-featured reading machine. 
Use any of today’s popular scanners to scan your favorite 
magazine, book, or newspaper article, and let OpenBook 
read that page aloud to you. Or open and edit an electronic 
file from any of today’s most popular applications. With 
OpenBook nothing is left inaccessible, and better yet, you are 
in control of how a page is read and presented.   

System Requirements 
The recommended system requirements for OpenBook 
include a personal computer with Windows 9x, Me, NT 4.0 
with Service Pack 6, 2000, or Windows XP Pro/Home. 

Specification Minimum Requirement 
Processor speed 166 MHz 
RAM 32 MB 
Available hard disk space 460 MB 
for typical installation 
Video Super VGA display 
Sound Windows compatible sound 

card and speakers 
Keyboard 104-key Keyboard 
Scanner A supported TWAIN­

compatible scanner or a 
supported Hewlett-Packard 
flatbed scanner 

CD ROM Drive 
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Installing OpenBook 

1. 	 Insert the OpenBook CD into your CD-ROM drive. 
2. 	 The OpenBook Setup program starts. You will hear the 

installation speak the instructions as they appear on 
your screen. Follow these instructions to complete the 
OpenBook installation. 

Note:	 Have your software serial number handy. The serial 
number is located on the outside of the box and on 
the outside of OpenBook’s CD jacket. When you 
type in your serial number be sure to include any 
dashes. 

If your OpenBook installation CD does not start automatically, 
go to the Start menu, select Run, and type D:\setup. If your 
CD-ROM drive is not D, substitute the correct drive letter. 

The OpenBook setup program will then begin.  

Choose to run the Typical or Custom installation of 
OpenBook. The Typical installation assumes that you want to 
install the default files along with ViaVoice™ Outloud and 
RealSpeak™ speech software, that you approve of 
OpenBook’s default location on your hard drive, and that you 
want to install the standard launchable programs. Use the 
Custom installation if you want to install additional 
synthesizers, specify which languages are installed, and/or 
specify where OpenBook is stored on your hard drive.  

Note:	 When you install OpenBook your scanner is 
automatically detected. 

Installing Connect Outloud 
During OpenBook installation you will be asked if you would 
like to install Connect Outloud. Installing Connect Outloud 
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with OpenBook provides you with speech and Braille access 
to the Windows Operating System and many components 
installed as part of that system including Internet Explorer and 
Outlook Express. The new Connect Outloud also provides 
speech support for Adobe® Acrobat Reader. 

If you currently have a screen reading product installed, it is 
recommended that you do not install Connect Outloud without 
consulting the manufacturer of your screen reader. 

Registering OpenBook 
Initial Registration 

Once you have completed the installation of OpenBook, you 
are ready to register your software license with Freedom 
Scientific. 

We encourage you to register your software. Registering your 
software costs you nothing, takes just a few minutes, and is 
the best way for you to receive quality service. Failing to 
register your software prevents us from providing you with 
technical support. 

To register: 

1. 	 Place the Registration disk in your disk drive. 

2. 	 Start OpenBook if it is not already running. 

3. 	 Go to the File Menu and select Open or press CTRL+O. 

4. 	 In the Filename edit box, type a:\registration.ark
and then press ENTER. 

5. 	 The registration document will open. 

6. 	Press CTRL+E to toggle to Edit Mode in OpenBook. 

7. 	Use your ARROW keys to move down the screen and 
enter the information requested. 
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8. 	 When finished, save the information by pressing 
CTRL+S. 

Note: To save a copy of this form on your computer, 
press ALT+F, A (for Save As) and then press 
ENTER. This saves a copy of the same file in the 
default folder on your hard drive. 

9. 	 If you live in the United States you can send the disk to 
Freedom Scientific in the self-addressed diskette 
envelope included in the software package. (This 
cardboard diskette envelope has the name Freedom 
Scientific embossed in Grade 2 Braille.) 

Changing Your Registration  
If you need to change your registration information, such as 
your address or phone number, open the Registration.ark file 
located in the folder where you installed OpenBook. The 
same questions appear as your initial registration. Change 
the necessary information, save it to a 3.5” floppy and send it 
to Freedom Scientific. 

Uninstalling OpenBook 
To uninstall OpenBook go to the Programs menu and select 
OpenBook. In the Tools submenu select the Uninstall 
OpenBook option. Uninstalling OpenBook does not uninstall 
Connect Outloud. If you choose to leave Connect Outloud on 
your system, it will run as a demo.  

Uninstalling Connect Outloud 
To uninstall Connect Outloud go to the Programs menu and 
select Connect Outloud 2.0. In the Tools submenu select the 
Uninstall Connect Outloud option. 
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Getting Started 

Launching OpenBook 

OpenBook gives you a variety of ways to launch the program.  
•	 Press the hot key, ALT+CTRL+O, which is automatically 

assigned when you install OpenBook. 
•	 Double-click the OpenBook icon on your desktop.  
•	 Go to the Start menu and select Programs. Choose 

OpenBook from the OpenBook submenu. 

Once launched, OpenBook opens with a blank untitled 
document from which you can begin working or if you prefer, 
you can change the startup document to be the document 
you were working on last. To do this, go to the Settings menu 
and select General Settings (ALT+G, G). In the General 
Settings dialog, press TAB until you arrive on the Open 
Untitled Document on Startup radio button. Press the DOWN 
ARROW key to select the Open Last Document on Startup 
radio button. 

Closing OpenBook 
You can close OpenBook like any other Windows application 
by pressing ALT+F4, pointing the mouse and left clicking on 
the X in the top right hand corner of the window, or selecting 
Exit from the File menu. 

Scanning and Reading 
OpenBook combines the best in scanning and reading 
features to convert printed media into electronic format. It 
then displays and reads the content aloud giving you access 
to material that would otherwise be inaccessible or difficult to 
read. 
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When you install OpenBook, IBM’s ViaVoice Outloud and 
ScanSoft’s RealSpeak speech software are also installed. 
You can scan, edit, or read a document. Additionally, you can 
customize the scanning, reading, and display properties of 
OpenBook. 

Here are a few shortcut keys to get you started with 
OpenBook. 
•	 To have OpenBook read to you, press NUM PAD 

ENTER, F10, or F12. 
•	 To scan, press NUM PAD INSERT or F4. 
•	 To toggle between Edit Mode and Read-only Mode, 

press CTRL+E. 
•	 To silence speech press the CTRL key. 
•	 To read faster, press CTRL+2. 
•	 To read slower, press CTRL+1. 
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Getting Help 

Online Help System 

OpenBook’s Online Help System is composed of three 
components, the Contents page with its tree view of books 
and topics, the Index page with its alphabetical listing of 
topics, and the Text View, which displays all topic content. 
When you launch Help, OpenBook automatically begins 
reading the contents of the Text View. To stop reading, press 
the CTRL key. To move from the Text View to the Tree View 
of books and topics, press F6. To return and begin reading 
the contents in the Text View, press F6 again. 

To navigate the books in the tree, use the UP and DOWN 
ARROW keys. The RIGHT ARROW key expands books to 
display its topics, while the LEFT ARROW key closes books. 
When you find the topic you want to read, press ENTER on 
the standard keypad. OpenBook Help displays that topic and 
automatically begins reading the contents. 

Note: To display the selected topic in the Text View, you must 
press ENTER. Simply moving back to the Text View 
without pressing ENTER does not display or read the 
newly selected topic. 

The Index page is particularly helpful if you are searching for 
a particular topic because it lists help topics in alphabetical 
order. To move between the Contents and the Index pages of 
Help, press CTRL+TAB. 

Navigating the Index’s list of topics is similar to navigating the 
Tree View of the Contents page in that you can use the UP 
and DOWN ARROW keys to move up and down the list of 
topics. Or if you know the topic you want to find, type its first 
letter. For instance, you want information on the Zoom feature 
of OpenBook. You would then type the letter Z. The Index 
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automatically moves through the list to that topic or to a topic 
that begins with the letter Z. 

You can also navigate OpenBook’s Help System by pressing 
the TAB key. When you press the TAB key, you cycle 
between the three controls in Help. Pressing the TAB key 
once activates the Tree View or Index list. Use the ARROW 
keys to navigate or open and close topics. Pressing the TAB 
key twice activates the Tab Control on the Contents or Index 
page. Use the LEFT and RIGHT ARROW keys to switch 
between the Contents or Index page. Pressing the TAB key 
three times activates the Text View where the topic contents 
are displayed. Here you can press F12 to read or the 
ARROW keys to navigate the contents. 

Context-Sensitive Help 
When you are in a dialog, press SHIFT+F1 or the NUM PAD 
MINUS key to read the context-sensitive help message for 
the current item. 

You can also access context-sensitive help by right-clicking 
with your mouse or by clicking on the ? (question mark) 
symbol at the top right corner of the dialog box. 

Technical Support 
If you do not find the answers to questions or problems that 
you have, contact Freedom Scientific Technical Support, 
(727) 803-8600 or e-mail Support@FreedomScientific.com. 
Office hours are from Monday through Friday 8:30 A.M. to 
7:00 P.M. Eastern Standard Time. 
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Please have the following information on hand: 
• Product serial number used for registration. 
• Product name and version number. 
• Type of computer hardware you are using. 
• Software version number of Windows. 

About OpenBook 
Select About OpenBook from the Help menu to view the 
version number of OpenBook you are currently running and 
its serial number. 
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OpenBook Keystrokes 

Reading Keys 

Read Dialog 

Read Status Bar 

Reading speed -- decrease 

Reading speed -- increase 

Read (Say All) 

Speech On/Off toggle 

Scanning Keys 
Toggle Recognize Columns 


Scan (Edit Mode) 


Scan (Read-only Mode)


Scanning Status 


Movement Keys 
Find text 

Find next occurrence of text 

Go To Bookmark 

Go To Page 

CTRL+B 

CTRL+SHIFT+F10 

CTRL+1 or SHIFT NUM PAD 
ASTERISK 

CTRL+2 or 
NUM PAD ASTERISK 

F10, F12 or 
NUM PAD ENTER 

CTRL+F5 

CTRL+SHIFT+Z 

F4 or NUM PAD INSERT 

SPACEBAR, F4, or 
NUM PAD INSERT 

SHIFT+F4 or 
NUM PAD SLASH 

CTRL+F 

CTRL+SHIFT+F 

F9 

CTRL+G 
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Where Am I 


Move Up One Line 


Move Down One Line 


Move Forward One 

Character (Edit Mode)


Move Back One Character 

(Edit Mode) 


Move Forward One Word 

(Read-only Mode) 


Move Back One Word 

(Read-only Mode) 


Move Up One Page 


Move Down One Page 


Move Up One Screen 


Move Down One Screen 


Highlight Next Word in the  

Unit 


Highlight Prev. Word in the 

Unit 


Move Spotlight to Previous 

Unit 


Move Spotlight to Next Unit 


Move Spotlight to beg. of 

doc 


Move Spotlight to end of 

doc 


Select Line Down 


NUM PAD 7 

UP ARROW 

DOWN ARROW 

RIGHT ARROW 

LEFT ARROW 

RIGHT ARROW 

LEFT ARROW 

NUM PAD PAGE UP 

NUM PAD PAGE DOWN 

PAGE UP 

PAGE DOWN 

CTRL+DOWN ARROW 

CTRL+UP ARROW 

CTRL+LEFT ARROW 

CTRL+RIGHT ARROW 

CTRL+HOME 

CTRL+END 

SHIFT+DOWN ARROW 
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Select Line Up 


Select Page Down 

(view page) 


Select Page Up (view page)


Select word to the right 

(Read-only Mode) 


Select character to the right 

(Edit Mode) 


Select word to the left 

(Read-only Mode) 


Select character to the left 

(Edit Mode) 


Select to beginning of Word  

(Edit Mode) 


Select Word to the left 

(Read-only Mode) 


Select to end of word 

(Edit Mode) 


Select to beginning of page 


Select to end of page 


Select to beginning of line 


Select to end of line 


Editing Keys 
Copy text 


Cut text (Edit mode) 


Delete Current Page 


SHIFT+UP ARROW 

SHIFT+PAGE DOWN 

 SHIFT+PAGE UP 

SHIFT+RIGHT ARROW 

SHIFT+RIGHT ARROW 

SHIFT+LEFT ARROW 

SHIFT+LEFT ARROW 

CTRL+SHIFT+LEFT ARROW 

CTRL+SHIFT+LEFT ARROW 

CTRL+SHIFT+RIGHT 
ARROW 

CTRL+HOME 

CTRL+END 

SHIFT+HOME 

SHIFT+END 

CTRL+C 

CTRL+X 

CTRL+DELETE 
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Delete Character 

Dictionary 

Edit Mode/Read-only Mode 
toggle 

Move Page Down in page 
order 

Move Page Up in page 
order 

Page Break, Insert 

Page Break, Delete 

Paste text (Edit mode) 

Replace text (Edit Mode) 

Select All text on current 
page (Edit Mode) 

Spell Check 

Spell Word 

Spell Word Phonetically 

Thesaurus 


Undo 


Page Layout Keys 
Start Page Description 

Enter Guided Layout Mode 

Exit Guided Layout Mode 

DELETE 

CTRL+D or F8 

CTRL+E 

ALT+PAGE DOWN 

ALT+PAGE UP 

CTRL+ENTER 

CTRL+SHIFT+DELETE 

CTRL+V 

CTRL+H 

CTRL+A 

F7 or CTRL+K 

CTRL+L, F3 twice, or NUM 
PAD 5 twice 

CTRL+SHIFT+L, F3 three 
times, or NUM PAD 5 three 
times 

CTRL+T or SHIFT+F8 

CTRL+Z 

CTRL+SHIFT+Y 

CTRL+SHIFT+F5 

ESC 
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Enter Explore Layout Mode 

Enter Explore Layout Mode 
from Guided Layout Mode 

Exit Explore Layout Mode 

Exit Explore Layout Mode  
and place cursor at current 
element in editor 

Pause/Resume Reading 
in Guided Layout Mode 

Read Element Contents/ 
Pause Reading/Resume 
Reading element contents 
in Explore Layout Mode 

Exact View / Text View 
Toggle 

Move to Next Element 

Move to Previous Element 

Other Useful Keys 
Bookmark, go to 

Bookmark, insert 

Bookmark, delete 

BuckScan money identifier 

Classic menus toggle On/Off 

Close current document 

Document Properties 

CTRL+SHIFT+ENTER 

ENTER 

ESC 

ENTER 

NUM PAD ENTER 

NUM PAD ENTER 

CTRL+SHIFT+V 

CTRL+SHIFT+DOWN 
ARROW 

CTRL+SHIFT+UP ARROW 

F9 

CTRL+F9 

CTRL+SHIFT+F9 

CTRL+M 

F2 

CTRL+F4 or CTRL+W 

CTRL+R 
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Exit OpenBook 

Help 

Help, context-sensitive help 

Key Describer toggle 

Menu key (Classic menus) 

New File 

Open File 

Print current document 

Properties 
(of open document) 

Save current document 

Status Bar toggle On/Off 

Start Open Book 

Toggle Windows

Word Count 

ALT+F4 

F1 or NUM PAD MINUS 

SHIFT+NUM PAD MINUS or 
SHIFT+F1 

NUM PAD 1 or CTRL+F12 

NUM LOCK 

CTRL+N 

CTRL+O 

CTRL+P 

CTRL+R 

CTRL+S 

SHIFT+F5 

ALT+CTRL+O 

CTRL+F6 

SHIFT+F7 

Using the NUM PAD on a portable PC 
You can use OpenBook on a portable notebook or laptop 
computer. However, most portable computers do not have 
standard 17-key keypads. We have therefore assigned 
alternate keys to the OpenBook NUM PAD functions. 

Menu F2 

Scan F4 or SPACEBAR 

Delete Page CTRL+DELETE 

Speak F10 or F12 
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Select ENTER 

Escape ESC 

Key Describer CTRL+F12 

Where Am I? SHIFT+CTRL+F12 

Help F1 

Voice Rate CTRL+1 and CTRL+2 

Scanning Status SHIFT+F4 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move Left LEFT ARROW 

Move Right RIGHT ARROW 

Page Up PAGE UP 

Page Down PAGE DOWN 
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JAWS Keyboard Layout Shortcuts 

General 

Key Describer 

Where am I? 

Beginning of Line 

End of Line 

Beginning of File 

End of File 

Beginning of Page 

Delete 

Page Up 

Page Down 

Reading Text 

INSERT+NUM PAD 1 

INSERT+NUM PAD 3 

NUM PAD 7 

NUM PAD 1 

CTRL+NUM PAD 7 

CTRL+NUM PAD 1 

ALT+NUM PAD 7 

DECIMAL 

NUM PAD 9 

NUM PAD 3 

*reading by character is possible only in edit mode 


Read Previous Character NUM PAD 4 

Read Current Character NUM PAD 5 

Read Next Character NUM PAD 6 

Read Previous Word INSERT+NUM PAD 4 

Read Current Word INSERT+NUM PAD 5 

Read Next Word INSERT+NUM PAD 6 

Read Current Line INSERT+NUM PAD 8 

Read Previous Sentence ALT+NUM PAD 8 
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Read Current Sentence 

Read Next Sentence 

Read Previous Paragraph 

Read Current Paragraph 

Read Next Paragraph 

Read from Beginning of Line 

Read to End of Line 

Read Continuously 

Selecting Text 

ALT+NUM PAD 5 

ALT+NUM PAD 2 

CTRL+NUM PAD 8 

CTRL+NUM PAD 5 

CTRL+NUM PAD 2 

INSERT+NUM PAD 7 

INSERT+NUM PAD 9 

INSERT+NUM PAD 2 

*selection by character is possible only in edit mode 


Select Prior Character 

Select Next Character 

Select Prior Line 

Select Prior Word 

Select Next Word 

Select Next Line 

Select to Beginning of Line 

Select to End of Line 

Select to Beginning of File 

Select to End of File 

SHIFT+NUM PAD 4 

SHIFT+NUM PAD 6 

SHIFT+NUM PAD 8 

INSERT+SHIFT+NUM PAD 4 

INSERT+SHIFT+NUM PAD 6 

SHIFT+NUM PAD 2 

SHIFT+NUM PAD 7 

SHIFT+NUM PAD 1 

CTRL+SHIFT+NUM PAD 7 

CTRL+SHIFT+NUM PAD 1 
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Window-Eyes Keyboard Layout 
Shortcuts 

General 
Where am I? 

Speak Key 

Beginning of Line 

End of Line 

Reading Text 

DECIMAL 

ENTER 

NUM PAD 7 

NUM PAD 1 

*reading by character is possible only in edit mode 


Read Previous Character NUM PAD 4 

Read Next Character NUM PAD 6 

Read Current Character NUM PAD 5 

Read Previous Line NUM PAD 8 

Read Next Line NUM PAD 2 

Read Current Line ALT+NUM PAD 8 

Read Previous Word ALT+NUM PAD 4 

Read Next Word ALT+NUM PAD 6 

Read Current Word ALT+NUM PAD 5 

Read from Beginning of Line ALT+NUM PAD 7 

Read to End of Line ALT+NUM PAD 9 

Read to End of Screen ALT+NUM PAD 2 
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